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Введение 
 
Galileo — это профессиональное программное обеспечение, разработанное компанией 
Forsta для медиа - маркетингового анализа и медиапланирования в печатных СМИ.  
 

Основные возможности Galileo:  
 анализ объемов аудитории медианосителей;  

 построение профиля аудитории медианосителей на базе социально-
демографических характеристик;  

 определение целевых групп потребителей различных товаров и услуг;  

 позиционирование торговых марок;  

 расчет и оптимизация показателей медиаплана в печатных СМИ.  
 

Для решения этих задач в Galileo используются следующие отчеты:  
 

Инструменты медиапланирования  
 «Выбор медиа» (Ranker) — инструмент для отбора медианосителей;  

 «План» (Planner) — инструмент для построения медиаплана для печатных СМИ;  

 «Оптимизатор» (Optimiser) — оптимизатор медиаплана для печатных СМИ;  
 

Таблицы  
 «Кросс-таблица» (Cross Table) — отчет для маркетингового анализа;  

 «Медиа-таблица» (Cover Table) — отчет для анализа аудитории медианосителей;  

 «Тренд по переменным» (Trend Cross Table) — отчет для построения динамики по 
переменным;  

 «Тренд по медиа» (Trend Cover Table) — отчет для построения динамики по 
медианосителям;  

 «Пересечение медиа» (Duplication Table) — отчет для анализа пересечения 
аудитории медианосителей;  

 «Анализ охвата N+» (OTS Table) — отчет для анализа распределения охвата на 
разных уровнях частоты контакта;  

 «Накопление охвата» (Cover Build Up Table) — отчет для анализа накопления 
аудитории медианосителей;  

 

Инструменты статистического анализа данных  
  «Кластерный анализ» (Cluster Analysis);  

 «Сегментационный анализ» (Segmentation Analysis);  
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Часть I.  

Общие приемы работы 

в Galileo 
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Начало работы 

Запустите программу Galileo с помощью ярлыка на рабочем столе.  

 

 
 
 
Загрузка базы данных  

Для того чтобы открыть базу данных, в рамках которой будут проводиться все расчеты, сделайте 

следующее:  

1. Нажмите кнопку («Открыть базу данных»).  
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2. Выберите нужный проект из списка доступных баз данных. Нажмите кнопку 

«Открыть». 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

Список доступных команд:   

— создать новую папку,  

— добавить новую базу данных в список,  

— удалить базу данных из списка,  

— поменять порядок следования баз данных,  

— переименовать базу данных,  

— присвоить базе данных название, заданное по умолчанию,  

— упорядочить базы в прямом/обратном алфавитном порядке,  

— отменить сортировку по алфавиту,  

— найти нужную базу данных,  

— найти переменную в списке баз данных.  

 

 

Для того чтобы добавить новую базу данных в список:  
 выделите мышкой папку, в которую следует поместить новую базу данных,  

 нажмите кнопку  («Добавить»),  

 найдите и откройте папку ... Galileo, выберите файл с расширением *.srv.  
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Вид окна Galileo сразу после загрузки базы данных:  
 
 

 

 

 
 

 
 
Выбор отчета  
После того как база данных загружена, необходимо выбрать отчет  через создание нового 

инструмента: 

 

Область отчета пуста 

Область, в которой осуществляется отбор 

элементов 
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Выбор элементов для построения отчета 

 
Область, в которой осуществляется отбор элементов для 

построения отчета 

 

 
 

 

 

 

 

Область, в которой осуществляется отбор элементов для построения отчета, содержит 6 

закладок:  

 

 

 «Survey»,  

 «Media»,  

 «Statistics»,  

 «Attributes»,  

 «Templates»,  

 «Find in Data».  
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Эти окна можно вывести на экран или скрыть через меню «View». 

 

 
 
Окно «Survey»  
В этом окне можно отбирать демографические и потребительские характеристики для 

добавления в отчет.  

 

Верхнее меню в окне «Survey» используется для работы с деревом демографических 

и потребительских переменных:  

 

— создать папку,  

— создать пользовательскую переменную,  

— удалить пользовательскую переменную,  

— редактировать пользовательскую переменную,  
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— эта кнопка регулирует список переменных, которые в данный 

момент отображаются в дереве (все, только пользовательские, только базовые), 

— найти переменную,  

— блокировать (запретить другим пользователям создавать переменные),  

— упорядочить переменные в прямом/обратном алфавитном порядке,  

— восстановить порядок по умолчанию.  

 

Население и выборка  

 

   В верхней части окна «Survey» указаны:  

 Universe (генеральная совокупность базы данных),  

 Sample (количество опрошенных респондентов).  
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Фильтрация дерева переменных  

     С помощью опции «Фильтр» можно быстро отобрать нужные переменные.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Удалить фильтр можно с помощью кнопки  («Снять фильтр»). 

 

Окно «Media»  
В окне «Media» отбираются медианосители для добавления в отчет.  
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Верхнее меню в окне «Media» предназначено для работы с деревом медиа-

переменных:  

— создать папку,  

— создать пользовательский синдикат,  

— удалить пользовательский синдикат,  

— редактировать пользовательский синдикат,  

— эта кнопка регулирует список медиа-переменных, которые в данный 

момент отображаются в дереве,  

— найти медиа-переменную,  

— фильтр по издателям, 

— редактировать цены,  

— упорядочить медианосители в прямом/обратном алфавитном порядке,  

— восстановить порядок по умолчанию.  

 

Окно «Statistics»  
Окно «Statistics» активно только в том случае, если открыт какой-либо отчет. Здесь 

можно отметить галками статистики, которые требуется рассчитать в отчете.  

 
 

Верхнее меню в окне «Statistics» предназначено для работы со списком статистик:  

— показать/скрыть все статистики из отчета,  
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— показать/скрыть только выбранные статистики,  

— переместить статистку вверх/вниз.  

           

          Для того чтобы отсортировать статистики по алфавиту, нужно кликнуть мышкой по   

          полю «Title».  

 
 

 

 

 

Окно «Attributes»  
Окно «Attributes» активизируется только в том случае, если открыт отчет, 

предназначенный для работы с медиа-переменными.  

 

Здесь содержатся атрибуты медианосителей (количество выходов рекламы, формат 

рекламы, цена 1 выхода рекламы и др.). Отметьте галками те атрибуты, которые нужно 

показать в отчете. 
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Верхнее меню в окне «Attributes» предназначено для работы со списком атрибутов:  

— показать/скрыть все атрибуты,  

— показать/скрыть выделенные атрибуты,  

— изменить порядок следования атрибутов. 

 

Окно «Templates»  

В Galileo доступна возможность по созданию шаблонов. Для этого постройте отчет и 

сохраните его как шаблон через меню File => Save as Template. Все сохранённые 

шаблоны будут доступны в окне Templates  

 

 
 

Обновите список шаблонов, нажав кнопку  («Refresh»).  

 

Путь к папке, где хранятся шаблоны, задается через меню Tools => Options => 

Directories. В поле «Templates» указывается путь к шаблонам. Например: 

C:\Galileo\GalileoFiles\template. 
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Окно «Find in Data» 
Здесь осуществляется поиск переменных и медианосителей 
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Принцип построения отчета 

 

В Galileo можно одновременно открыть несколько отчетов. В этом примере созданы три 

отчета. Переключиться с одного отчета на другой можно, кликнув мышкой по закладке 

с названием отчета.  

 

 
 

В таблице Galileo указывается размер генеральной совокупности, внутри которой 

рассчитываются данные. Например, «Size: 6 569,892 (3 000)» означает следующее:  

 генеральная совокупность (т.е. население Казахстана в возрасте 15+, проживающие в 

городах с численностью 100 000+) = 6 млн. 569 тыс. 892 человека,  

 выборка = 3 000 человек.  

 

Добавление переменных в таблицу  
Для того чтобы добавить переменные в таблицу, выделите нужные характеристики в 

дереве (слева) и перенести их с помощью мышки на белое поле таблицы (направо). 

Поле таблицы условно разделено по диагонали на две области:  
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 если направить курсор мышки в «Область 1», переменные будут добавлены в 

строки,  

 если направить курсор мышки в «Область 2», переменные будут добавлены в 

столбцы.  

 

 

 

 

 

Изменение порядка следования переменных в таблице  
Если необходимо поменять порядок следования переменных в таблице, подцепите 

мышкой нужную переменную и переместите выше или ниже по оси.  

 

 

Удаление переменных  
Для того чтобы удалить переменные из таблицы, выделите их с помощью мышки и 

нажмите «Delete» на клавиатуре.  

  



Galileo 6.28 

20 
K Research Central Asia 2025 

Задание целевой группы  
В том случае, если требуется рассчитать данные в таблице не для всей генеральной 

совокупности, а для ее части, можно задать целевую группу. Целевая группа будет 

служить фильтром для всех расчетов в таблице.  
 

Для того чтобы задать целевую группу, сделайте следующее:  

 в окне «Survey» выберите нужную характеристику,  

 с помощью мышки перенесите эту характеристику на поле «Целевая группа» над 

таблицей.  

 

 

В этом примере данные в таблице будут рассчитаны для целевой группы «Люди в 

возрасте 15-24 лет». Размер целевой группы: 1 млн 036 тыс 490 (652) = 15,8%.  

Это означает следующее:  

 количество человек в целевой группе = 1 млн. 36 тыс. 490человек в возрасте 

15+, проживающих в городах 100 000+ (что составляет 15,8% от генеральной 

совокупности),  

 выборка в целевой группе = 652 человека в возрасте 15 +, проживающие в городах 

100 000+, участвовали в исследовании.  
 

Для того чтобы убрать целевую группу, перенесите переменную из поля «Целевая 

группа» обратно в дерево переменных с помощью мышки.  
 

Задание комбинированной целевой аудитории  
Если планируется сочетать два разнородных признака: например, населенный пункт и 

демографическую характеристику, — имеет смысл задать комбинированную целевую 

группу.  
 

Для того чтобы задать комбинированную целевую группу, сделайте следующее:  

 выберите первую характеристику (в окне «Survey»), например, «Населенный пункт. 

Алматы» и с помощью мышки перенесите в поле «Target Base»,  

 выберите вторую характеристику, например, «Пол. Женский» и с помощью мышки 

перенесите на поле «Target Group».  
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В итоге данные в таблице будут рассчитаны для целевой аудитории «Населенный 

пункт.Алматы, Пол.Женский».  
 

Размер целевой группы: 859 тыс. 280 (381) = 56.0%. Это означает следующее:  

 количество человек в целевой группе 859 тыс. 280 женщин, проживающих в г. 

Алматы, что составляет 56,0% от населения Алматы в возрасте 15 лет и старше  

 выборка в целевой группе = 381 женщина в возрасте 15 лет и старше, проживающая в 

г. Алматы, участвовали в исследовании.  

 

Копирование данных из Galileo в MS Excel  

Выделите область в таблице Galileo и нажмите кнопку  («Копировать»). Затем 

откройте MS Excel и нажмите кнопку  («Вставить»). Также кнопки 

«Копировать»/«Вставить» позволяют перемещать переменные между отчетами 

Galileo: например, можно скопировать медианосители из отчета «Cover table» и добавить 

в отчет «Planner».  

 

Копирование названий папок и подпапок из Galileo в MS Excel  
Из Galileo в Excel можно копировать названия папок, в которых находятся переменные. 

Для этого поставьте галку «Копировать названия папок» в меню Tools => Options 

=> Table Report.  

 
 

Экспорт данных из Galileo в Excel  

Отчеты можно экспортировать из Galileo в MS Excel с помощью кнопки  «Export to 

Excel». 
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В результате отчет будет экспортирован в MS Excel.  

 
 

Копирование отчетов со ссылкой на источник  
Отчеты можно копировать вместе с верхним и нижним колонтитулом. Для того чтобы 

задать колонтитулы, зайдите в меню File => Page Setup. На закладках «Header» и 

«Footer» задайте соответственно верхний и нижний колонтитулы.  

 

 

 

Сохранение документа  
Документ Galileo можно сохранить через меню File => Save As или с помощью кнопки 

 («Сохранить») на панели инструментов. 
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Построение диаграмм 

 
Прежде чем строить диаграмму, зайдите в меню Tools => Options => Documents => 

Chart. В поле «Chart type» выберите «Диаграмма Microsoft Excel».  

 

Чтобы построить диаграмму:  

 выделите область в таблице,  

 перенесите мышкой прямоугольник  в левый верхний угол таблицы на поле 

«Новый слой»,  

 нажмите кнопку  («Построить диаграмму») на панели инструментов.  

  

 

 

Будет создана диаграмма в формате MS Excel. Редактирование диаграммы аналогично 

редактированию в MS Excel.  

 

 
 

 

 

Диаграмма Excel связана с таблицей. Любые изменения в таблице приводят к 

изменению на графике.  

 

Диаграмму можно сохранить через меню File => Save As Workbook MS Excel. 
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Основные настройки Galileo 

 
Меню Tools / Сервис => Options / Параметры или кнопка (Options / Параметры) на 

панели инструментов.  

 
 

 

Секция «Table Report»  

 

 Можно установить режим автоматического пересчета таблиц Galileo. Для этого поставьте 

галку «Recalculate on any change» / «Автоматический расчет» в меню Tools / 

Сервис => Options / Параметры => Documents / Документы => Table report / 

Таблица.  

 

Секция «Decimals» / «Количество дробных знаков»  

 

 Здесь задается количество знаков после запятой для каждой статистики.  

 

Секция «Directories» / «Директории»  

 

Основные опции:  

 «Templates» / «Шаблоны» — путь к шаблонам Galileo. Например: 

C:\Galileo\GalileoFiles\Templates.  

 «Databases» / «Базы данных» — путь к архиву баз данных.  

 «Live Update» / «Автообновление» — путь к эталонной версии Galileo.  

 

Секция «Initialisation»  

 

 В поле «Open Media можно задать медиа-данные, которые будут автоматически 

открываться при запуске Galileo.  

 В поле «Open Survey» можно задать базу данных, которая будет автоматически 

открываться при запуске Galileo.  
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Часть II. Описание 

основных инструментов 
Galileo  
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Построение пользовательских переменных 

 
Общее описание  
 

Пользовательские переменные  
Вы можете создавать самостоятельно на основе переменных, изначально присутствующих в базе 

данных. Так, например, изначально в базе данных могут быть два отдельных признака 

«мужчины» и «высшее образование». Чтобы объединить эти признаки в одну группу «мужчины с 

высшим образованием», нужно построить пользовательскую переменную. При этом 

характеристики «мужчины» и «высшее образование» связываются логическим оператором AND.  

 

Связки между переменными  
 

Логические операторы: 

Логическое «и» (позволяет создать группу, которая удовлетворяет одновременно 

нескольким заданным условиям).  

 

Логическое «или» (позволяет создать группу, которая удовлетворяет хотя бы одному из 

заданных условий). 

 

Оператор задает границы интервала (например, age in 30.. 40). 

 

  

Оператор задает промежуток между границами интервала.  

 

 

Логические скобки (используются для того, чтобы дать программе установку 

выполнять операторы в определенной последовательности).  

 

Логическое отрицание (позволяет выделить группу, которая не удовлетворяет 

заданному условию). 

 

Операторы сравнения: 

 
«равно», 
 
«не равно», 
 
«меньше», 
 
«меньше или равно», 
 
«больше», 
 

«больше или равно». 

 

 

Пример использования логических операторов: 

 

AND (логическое «и»): 

Если необходимо, чтобы итоговая группа обладала одновременно двумя признаками: и 

признаком «мужчины», и признаком «возраст.20-30», — используется оператор AND. В 

результате получается группа «мужчины в возрасте 20-30 лет». 

 

OR (логическое «или»): 

Если необходимо, чтобы итоговая группа обладала хотя бы одним из признаков: либо «Пьют 

чай», либо «Пьют кофе», — используется оператор OR. В результате получается группа «Пьют 

чай или кофе». 
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Классификация переменных  
 

По типам:  

 

 Логическое выражение (Logical) — логическая переменная: задает условие, которое 

выделяет определенную группу людей из всего населения.  

 Целое число (Integer) — целочисленная переменная: каждому человеку ставится в 

соответствие целое число.  

 Дробное число (Real) — нецелочисленная переменная: каждому человеку может быть 

поставлено в соответствие целое или дробное число.  

 Категории (с единственным выбором) (Single Categorical) — переменная с 

несколькими категориями, при этом каждый человек включается только в одну категорию. 

Например, переменная «Пол»: респондент указывает либо мужской, либо женский пол.  

 Категории (с множественным выбором) (Multiple Categorical) — переменная с 

несколькими категориями, при этом каждый человек может быть включен сразу в 

несколько категорий. Например, переменная «Потребление марок сока». Отвечая на 

вопрос о потреблении марок сока, респондент может выбрать сразу несколько марок.  

 Вероятность (Probability) — вероятностная пользовательская переменная строится на 

основе медиа-переменных.  

 

 

По способу хранения в базе данных:  

 

 Постоянная Общая (Permanent Public) — пользовательская переменная, доступная 

всем пользователям, сохраняется в базе данных после закрытия.  

 Постоянная Приватная (Permanent Private) — пользовательская переменная, 

доступная только одному пользователю, сохраняется в базе данных после закрытия.  

 Временная (Temporary) — временная пользовательская переменная, с которой можно 

работать до закрытия базы данных. После закрытия базы данных переменная не 

сохраняется.  

 

 

Создание логической пользовательской переменной  
 

Откройте «New Target Group» , нажав на кнопку   

 

 

 

Откроется «Build User Variable» / «Мастер переменных».  
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С помощью мышки перенесите переменные (из дерева слева) в окно «Build User 

Variable» (направо).  

 
 

 

 

Новые переменные можно перенести внутрь сегмента или создать новый сегмент.  

  

Добавить переменную внутрь сегмента  

 

Создать новый сегмент  

 

Сегмент — это группировка переменных, объединенных логическими связками. Все 

связки в рамках одного сегмента одинаковы: либо все AND, либо все OR. Смена 

оператора осуществляется кликом мышки по оператору.  

Пример  

 

Сегмент 1:  

Мужчины AND Возраст: 15-24 AND потребители чая  
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Сегмент 2:  

Мужчины AND Возраст: 15-24 AND потребители кофе 

 

 
 

 

Можно объединить несколько сегментов с помощью логических связок AND или OR.  

Схлопывание категорий внутри сегмента  

Если в сегмент добавлена переменная с большим количеством категорий, то список категорий 

удобно свернуть.  

 

 

 

 

Редактор выражения  

Если нужно усложнить переменную (например, добавить оператор NOT  или выбрать 

произвольный возраст) — это можно сделать, переключившись в режим «ручной» правки 

выражения, нажав кнопку «Switch to Expression Mode» / «Редактор выражения» в 

нижней части окна.  
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Окно примет следующий вид:  

 

 
 

 

 

В это окно можно перенести переменные из дерева «Переменные» с помощью мышки. 

 

Сохранение переменной 

Задайте имя переменной  

 

 
 

 

 

Нажмите кнопку  

 

 

В открывшемся окне нужно создать папку с помощью кнопки («New Class») или выбрать 

уже созданную директорию и нажать «OK».  
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Созданная переменная появится в дереве переменных. 
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Теперь с этой переменной можно работать в любых отчетах Galileo. Если в дальнейшем 

возникнет необходимость отредактировать пользовательскую переменную, кликните два раза 

мышкой по названию переменной.  

 

Пользовательские переменные можно копировать из одной базы данных в другую с помощью 

кнопок «Копировать»/«Вставить» или Ctrl+C/Ctrl+V. 

 

Создание переменной, состоящей из нескольких категорий  
Для того чтобы начать построение, нажмите кнопку  («Target Audience»).  

 
 

В открывшемся окне нажмите на Select в строке Target Group. Далее в открывшемся окне 

Variables нажмите на New Variable. Откроется окно Build User Variable.   

В нижней части открывшегося окна нажмите кнопку «Редактор выражения». 

 
 

 

 

Задайте тип переменной Single Categorical или Multiply Categorical. Подробное описание 

типов переменных читайте в разделе «Классификация переменных».  

 
 

 

Чтобы создать Категорию 1, перенесите нужные характеристики с помощью мышки из дерева 

переменных на поле «Expession». 
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Используйте операторы AND, OR, NOT и т.д. для того, чтобы сформировать логическое 

выражение данной категории.  

 
 

Чтобы добавить еще одну категорию, нажмите кнопку «Add».  

 
 

 

Создайте несколько категорий.  

 
 

Для каждой категории задайте логическое выражение и название Категории.  

 

 
 

Можно автоматически задать названия категорий с помощью кнопки  («Задать имя») или 

задать имя вручную и рассчитать размер сегментов, нажав кнопку  

 

 
 



Galileo 6.28 

34 
K Research Central Asia 2025 

Задайте имя переменной.  

 
 

 

Нажмите на кнопку ОК и в открывшемся окне Save Variable выберете место, в котором хотите 

сохранить созданную переменную в дереве переменных.  

 
 

 

Теперь с этой переменной можно работать в любых отчетах Galileo. Если в дальнейшем 

возникнет необходимость отредактировать пользовательскую переменную, кликните два раза 

мышкой по названию переменной.  

 

Пользовательские переменные можно копировать из одной базы данных в другую с помощью 

кнопок «Copy»/«Paste» или Ctrl+C/Ctrl+V. 

 

Кросс-таблица (Cross Table) 
Функция  

Инструмент предназначен для построения таблиц пересечений демографических и 

потребительских переменных.  

 

Построение  

 

 Нажмите кнопку  («New»)  
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 В левой части окна выберите отчет «Cross table».  

 Нажмите «ОК».  

 

 
 

 

Откроется «Cross table-таблица» 
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В левой части окна представлен список всех переменных, доступных для анализа. Если 

выделить мышкой переменную, в нижней части окна отобразятся ее категории.  

 

 
 

С помощью функции «Фильтр» можно быстро отобрать нужные переменные.  

 

Чтобы добавить переменные в столбцы, надо с помощью мышки перенести переменные на белый 

фон таблицы ближе к полю Column (столбцы). Чтобы добавить переменные в строки, перенесите 

их на белый фон таблицы ближе к полю Row (строки). 

 

Таблица, в которую добавлены переменные, выглядит следующим образом:  
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Чтобы рассчитать данные, нажмите кнопку («Calculate») на верхней панели 

инструментов. Если нужно, чтобы данные всегда рассчитывались автоматически, отметьте 

галкой опцию «Recalculate on any change» в меню Tools => Options => Documents => 

Table Report.  

 

Пример интерпретации статистик  
 w.Total — выражение в тысячах человек. Например, 318 тыс. 132 человек в возрасте 15-

19 лет потребляют чай несколько раз в день. 

 Col%Weighted — процент по столбцу. Например, 66.4% людей в возрасте 15-19 лет 

потребляют чай несколько раз в день. 

 Row%Weighted — процент по строке. Например, среди тех, кто потребляет чай 

несколько раз в день люди в возрасте 15-19 лет составляют 6.1%. 

 wAffinity — индекс соответствия целевой группе: отношение процента в группе к 

проценту во всем населении, умноженное на 100. Индекс показывает, насколько 

выраженность признака в группе отклоняется от его выраженности во всем населении. 

Например, для характеристики «Частота потребления чая» в возрастной группе 15-19 лет 

Affinity = 81. Очевидно, что для людей в возрасте 15-19 лет менее характерно, чем для 

населения в целом, потреблять чай несколько раз в день. Вероятность встретить людей в 

возрасте 15-19 лет в группе людей, потребляющих чай несколько раз в день, в 0.81 раза 

ниже, чем вероятность встретить людей в аналогичном возрасте во всем населении.  

 Sample – количество респондентов, ответивших на вопрос.  Например, 205 респондентов 

в возрасте 15-19 лет ответили, что потребляют чай несколько раз в день. Значение 
Sample, достаточное для анализа, должно быть не менее 30 человек  

Добавление статистик в отчет  
Если нужно добавить дополнительные статистики, воспользуйтесь окном «Statistics» 

      

 
 

 Или кнопкой  

 

Редактирование построенных осей  
Чтобы добавить переменные в уже построенный отчет, перенесите переменные внутрь таблицы 

на поле рядом с теми переменными, которые уже есть в таблице.  

Удалить переменную можно, выделив ее в таблице и нажав на клавиатуре «Delete». Другой 

способ удаления переменной из таблицы — перенос с помощью мышки обратно в дерево 

переменных.  
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Сортировка данных в таблице  
В «Cross table» предусмотрено два способа сортировки:  

 

1. Сортировка категорий внутри переменных. Добавьте в «Cross table» несколько 

переменных, например, «Потребление марок чая» и «Потребление марок печенья», и 

рассчитайте данные. Затем выделите статистику, по которой нужно отранжировать марки 

(например, Col%), и нажмите одну из кнопок сортировки .  

 
 

Марки будут отсортированы внутри каждой переменной. 

 
 

 

 

2. Сплошная сортировка. Добавьте в «Cross table» несколько переменных, например, 

«Потребление марок чая» и «Потребление марок печенья», и рассчитайте данные. Затем 

нажмите кнопку («Split»).  

 
 

Теперь, если отранжировать категории с помощью кнопок , будет выполнена сплошная 

сортировка всех марок чая и печенья. 
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Объединение категорий  
Для того чтобы объединить несколько категорий, надо выделить эти категории и нажать 

кнопку («Merge»).  

 
 

 

 

  В этом примере в группу попадут все люди, которые потребляли хотя бы одну из  

  выделенных марок.  
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Для того чтобы вернуться к первоначальному виду, надо выделить объединенную строку и 

нажать («Unmerge»).  

 
 

Изменение ориентации осей  
Для удобства работы с таблицей можно поменять местами строки и столбцы. Чтобы это 

сделать, мышкой поменяйте местами прямоугольники Variable и Variable 2 в правом верхнем и в 

левом нижем углах таблицы.  

До: 
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После:  

 
 

Разделение оси таблицы  
Если на одной из осей таблицы находятся несколько переменных с идентичным списком 

категорий, имеет смысл придать такой таблице более удобный для анализа вид. Для этого 

кликните правой кнопкой мышки по прямоугольнику    и выберите команду «Split Edge 

/ Разделить ось». 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Чтобы вернуть таблицу к первоначальному виду, кликните правой кнопкой мышки по 

прямоугольнику «Variable» и выберите команду «Merge Edge». 
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Цвет ячеек  
Цвет ячеек позволяет визуализировать разницу между значениями.  

 
 

Таблицу с цветовой заливкой можно копировать в MS Excel только с помощью кнопки 

(«Экспорт в Excel»). Стандартные функции «Копировать»/«Вставить» не переносят в MS Excel 

цвет ячеек.  

 

Для того чтобы настроить цветовые различия, нажмите кнопку «Advanced Options» в меню 

Tools => Documents => Table Report. В открывшемся окне в поле «Legend» нужно 

поставить галки «Highlight cells» и «Show legend». 

 
 

 

 

Предусмотрено два типа цветовой шкалы:  

 шкала с «плавающими» границами: границы градиентной заливки определяются 

автоматически относительно минимального и максимального значений в данной таблице,  

 шкала с фиксированными границами: границы задаются пользователем.  
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По умолчанию задана цветовая шкала с «плавающими» границами. Вы можете 

отредактировать цвета градиента. Для этого кликните два раза мышкой по прямоугольнику

 в правом верхнем углу таблицы. В открывшемся окне для каждой статистики 

отображаются текущие настройки цветовой шкалы.  

 
 

 

 

Как поменять цвет  

Выделите цвет, который нужно поменять, и нажмите кнопку . Затем задайте новый цвет.  

 
 

 

 

Если нужно зафиксировать границы цветовой шкалы (т.е. привязать минимум и максимум к 

конкретным значениям), снимите галку «Automatic scale» и задайте «Maximal» и «Minimal» 

в колонке «Limit». 
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Медиа-таблица (Cover Table) 
 

Функция  
Инструмент предназначен для построения таблиц пересечений аудитории медианосителей и 

демографических/маркетинговых характеристик. Используется для анализа структуры аудитории 

медианосителей.  

 

Построение  

Нажмите кнопку  («New»).  

 
 

 

В левой части окна выберите отчет «Cover Table».  

Нажмите «ОК».  
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Откроется «Медиа-таблица». 

 
 

 

В этой таблице можно работать с двумя видами переменных:  

1)  Медиа-переменные (окно «Media»)  

 
 
 

 

2)  Демографические/потребительские 

переменные (окно «Survey»)  

 
 

 

 

Добавьте медианосители в таблицу. Для этого перенесите их с помощью мышки из окна 

«Media» на белое поле таблицы. Таблица примет следующий вид: 
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Чтобы рассчитать данные, нажмите кнопку  («Рассчитать») на верхней панели 

инструментов.  

 

Если нужно, чтобы данные всегда рассчитывались автоматически, отметьте галкой опцию 

«Recalculate on any change» в меню Tools => Options => Documents => Table Report.  

 

Добавьте демографические переменные в таблицу. Для этого перенесите с помощью мышки 

нужные характеристики из дерева «Survey» на белое поле таблицы ближе к прямоугольнику 

.  

Например, если добавить переменную «Пол», таблица примет следующий вид:  

 
 

 

Чтобы удалить переменную, выделите ее и нажмите «Delete» на клавиатуре. Другой способ 

удаления переменной из таблицы — перенос с помощью мышки обратно в дерево переменных.  

 

Добавление статистик в отчет  
Если нужно добавить / удалить статистики, воспользуйтесь окном «Statistics». 
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Суммарная аудитория нескольких медианосителей  
Для того чтобы рассчитать суммарную аудиторию нескольких медианосителей, надо выделить 

эти медианосители внутри таблицы и нажать кнопку  («Merge»).  

 
 

 

 

Результат:  
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В этом примере «Plan 1» показывает суммарную аудиторию одного номера двух изданий 

«Аргументы и Факты» и «Время (ежедневная)». Суммарная аудитория одного номера — это 

группа людей, которые читали один средний номер хотя бы одного из перечисленных изданий.  

 

Для того чтобы вернуться к первоначальному виду, надо выделить объединенную строку и 

нажать кнопку  («Unmerge»). 

 
 

 

Пример интерпретации статистик  

 
 

 Cover — охват аудитории медианосителя в целевой группе (в тыс. человек). Для изданий 

эта статистика отображает AIR (Average Issue Readership), т.е. среднюю аудиторию 

одного номера издания. Например, каждый номер издания «Аргументы и Факты» в 

среднем читают 85 620 мужчин в возрасте 15+, проживающих в городах РК 100 000+.  

 Cvr % — охват аудитории медианосителя в целевой группе (в %). Например, каждый 

номер издания «Аргументы и Факты» в среднем читают 2.88% мужчин.  

 Row% Cover — доля демографической группы в аудитории медианосителя (в %). 

Например, доля мужчин в аудитории «Аргументы и Факты» = 57,5%.  

 Conv. Index — индекс соответствия целевой группе (аналогичен Affinity): отношение 

объема аудитории в целевой группе к объему аудитории во всем населении, умноженное 

на 100. Например, для издания «Аргументы и Факты» в группе мужчины Conv. Index = 

127. Индекс показывает, что для мужчин более характерно, чем для населения в целом, 

читать «Аргументы и Факты». Вероятность встретить мужчину в аудитории издания в 1.27 

раза выше вероятности встретить мужчину во всем населении.  

 

* * * 

 

В «Cove table» поддерживаются все возможности работы с таблицей, которые описаны в 

разделе «Cross table». 
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Выбор медиа (Ranker) 
 

Функция  
Инструмент используется для ранжирования медианосителей в целевых группах.  

 

Построение  

 Нажмите кнопку  («New»).  

 
 

 В левой части окна выберите отчет «Ranker».  

 Нажмите «ОК».  
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Откроется отчет «Ranker».  

 
 

Чтобы добавить медианосители в таблицу, выделите их в окне «Media» (слева) и перенесите на 

пустое поле (направо). 

 
 

 

Чтобы добавить целевую группу, выберите нужную характеристику в окне «Survey» и 

перенесите ее на поле «Target Group» над таблицей. Таблица, в которую добавлена целевая 

группа, выглядит следующим образом: 
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Для того чтобы добавить еще одну целевую группу в отчет, откройте окно «New Target» в 

нижней части окна.  

 
 

 

B выберите еще одну целевую группу 

 
 

Каждая целевая группа находится на отдельной закладке.  
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Если нужно удалить медианоситель из отчета, выделите его в таблице, кликнув по его номеру, и 

нажмите на клавиатуре «Delete».  

 

Добавление атрибутов и статистик в отчет  
Если нужно добавить дополнительные атрибуты и статистики в отчет, воспользуйтесь окнами 

«Attributes» и «Statistics».  

 

Окно «Attributes» 

 

 

Окно «Statistics» 

 

  

Для каждого медианосителя можно задать атрибуты:  

 Quantity — количество рекламных вставок.  

 Price format — формат рекламного сообщения. Для того чтобы изменить формат, надо 

подвести мышку к ячейке в колонке «Формат», два раза кликнуть мышкой по ячейке 



Galileo 6.28 

53 
K Research Central Asia 2025 

(или нажать F2) и выбрать требуемый формат. В рамках БД MMI Price format не 

формируется. 

 

 Unit price — стоимость одного размещения рекламного сообщения формата User defined. 

Стоимость заносится / редактируется вручную.  

 Discount — скидка в %. Если нужно задать несколько последовательных скидок, 

используйте знак «+» между скидками.  

 Total price — суммарная стоимость размещения с учетом количества рекламных вставок и 

скидок.  

 Date — текущая дата формирования / обновления цены.  

 Медиа-вес — коэффициент, который применяется к охвату медианосителя (т.е. к 

статистике Cover). Используется в случае, когда предполагаемая аудитория рекламного 

сообщения меньше аудитории медианосителя. Диапазон коэффициента: от 0 до 1.  

 

Ранжирование медианосителей  

Для того чтобы отранжировать медианосители, кликните мышкой по столбцу (статистике). 

Первый щелчок мышкой ранжирует по убыванию, второй — по возрастанию. 

 
 

 

Integrated Index  
Integrated Index — это показатель, который позволяет учитывать одновременно несколько 

параметров при выборе медианосителей. По умолчанию Integrated Index строится на 

основании 3 статистик:  

 Cover % — охват медианосителя в целевой группе,  

 TGI — индекс соответствия целевой группе,  

 CPT Cover — стоимость достижения тысячи человек в целевой группе.  

 

Если отранжировать издания по убыванию по статистике Integrated Index, то «сверху» 

окажутся медианосители, наиболее подходящие по 3 отобранным параметрам.  

 

Вы можете поменять статистики, формирующие Integrated Index, и сформировать свой 

индивидуальный критерий Integrated Index. Для этого нажмите кнопку . Откроется окно 

«Change Integrated Index». 
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В открывшемся диалоговом окне задайте, во-первых, статистики, на основании которых будет 

рассчитан Integrated Index, а во-вторых, коэффициенты значимости для каждой из выбранных 

статистик. Важно помнить, что сумма коэффициентов должна быть равна 1.  

 
 

Результат будет выглядеть следующим образом: 

 
 

 

 

В следующем примере Integrated Index был отредактирован. Заданы две статистики: Cvr % (с 

коэффициентом значимости 0.75) и TGI (с коэффициентом значимости 0.25). Таким образом, 

при расчете Integrated Index охват издания будет учитываться на 75%, а индекс соответствия 

целевой группе — на 25%.  
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Формула расчета показателя Integrated Index:  

 

Integrated Index = (Stat1/maxStat1) * k1*100 + (Stat2/maxStat2) * k2*100 + 

(Stat3/maxStat3) * k3*100 

 

где:  

 Stat1, Stat2, Stat3 — нормированные значения статистик для конкретного 

медианосителя,  

 maxStat1, maxStat2, maxStat3 – максимальное значения статистики по столбцу 

 k1, k2, k3 — коэффициенты значимости для выбранных статистик.  
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Пример интерпретации статистик  

 
 

 

Заданы атрибуты:  

 

 Quantity = 1. Один выход в газете Караван.  

 Price format = «произвольный».  

 Unit price = 550 000. Стоимость рекламного сообщения формата «произвольный» по 

прайс-листу = 550 000 тенге.  

 Discount = 15. Скидка 15%  

 Total price = 467 500 тенге. Стоимость выхода с учетом скидки = 467 500 тенге.  

 

Рассчитаны статистики:  

 

 Cover — охват аудитории медианосителя в целевой группе (в тыс. человек). Для изданий 

эта статистика отображает AIR (Average Issue Readership), т.е. среднюю аудиторию 

одного номера издания. Например, каждый номер издания «Караван» в среднем читают 

49,5 тыс. людей в возрасте 25–44 лет.  

 Cvr % — охват аудитории медианосителя в целевой группе (в %). Например, каждый 

номер издания «Караван» в среднем читают 1.67% людей в возрасте 25–44 лет.  

 Composition — доля целевой группы в аудитории медианосителя (в %). Например, 

аудитория издания «Караван» на 38.39% состоит из людей в возрасте 25–44 лет.  

 TGI (Target Group Index/Universe) — индекс соответствия целевой группе (аналогичен 

Affinity): отношение объема аудитории в целевой группе к объему аудитории во всем 

населении, умноженное на 100. Например, для издания «Караван» в группе «люди в 

возрасте 25–44 лет» TGI = 85. Индекс показывает, что для людей в возрасте 25–44 менее 

характерно, чем для населения в целом, читать «Караван». Вероятность встретить людей 

в возрасте 25–44 лет в аудитории издания в 0.85 раза ниже вероятности встретить людей 

в возрасте 25–44 лет во всем населении.  

 CPT Cover (Cost Per Thousand) — стоимость достижения тысячи человек в целевой 

группе. Рассчитывается по формуле: CPT Cover = Стоимость / Cover. Например, для 

издания «Караван» CPT Cover = 9 444,63 тенге. Это значение рассчитано следующим 

образом: 467 500 тенге / 49.5 тыс. чел. = 9 444.63 тенге округленно. При одном 

размещении рекламы в издании «Караван» достижение каждой тысячи людей в возрасте 

25–44 лет будет стоить рекламодателю 9 444 тенге.  
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График медиа (Scatter Plot)  
Медианосители, отобранные в отчете «Ranker», можно отобразить на диаграмме. Для этого 

выделите медиа и нажмите кнопку (« Scatter Plot»).  

 
 

 

Будет построен «Scatter plot».  

 
 

 

 

Положение точек на диаграмме определяется значениями Cover и TGI. 

Для того чтобы изменить параметры осей, нажмите кнопку «Properties» на панели 

инструментов.  
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На закладке «Axes» задайте статистики на ось X и ось Y.  

 
 

На закладке «Font» можно задать шрифт подписей на диаграмме. 

 
 

 

Диаграмму можно скопировать в MS Excel с помощью кнопки («Copy» / Ctrl C). В MS Excel 

нажмите кнопку «Paste» / Shift Ins. 
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План (Planner) 
 

Функция  
Инструмент для медиапланирования в прессе.  

 

Построение  

 Нажмите кнопку  («New»).  

 

 
 

 В левой части окна выберите отчет «Planner».  

 Нажмите «ОК».  
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Откроется «Planner».  

 
В левой части окна в дереве «Media» представлен список медианосителей. Чтобы добавить 

медианосители в план, выделите переменные с помощью мышки в дереве (слева) и перенесите 

на пустое поле отчета (направо).  

 

В момент переноса медиа-переменных в отчет, откроется окно редактирования атрибутов 

медианосителей. Можно либо нажать «OK», пропустив этот этап, либо внести необходимую 

информацию.  

 
 

 

Чтобы задать целевую группу, перенесите нужную переменную из окна «Survey» (слева) на 

поле «Target Group». 
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Напротив каждого издания в столбце «Plan 1» задайте количество рекламных выходов. 

Нажмите кнопку («Calculate») для расчета показателей медиаплана. 
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Если необходимо отредактировать стоимость размещения рекламы, переключитесь на закладку 

«Plan 1» и внесите изменения 

 
 

 

Чтобы удалить медианоситель из плана, выделите его мышкой и нажмите на клавиатуре 

«Delete». 

 

Создание нескольких медиапланов  

Для того чтобы добавить еще один план (т.е. создать новую колонку), нажмите кнопку 

(«Add plan») на верхней панели инструментов.  

 
 

В результате будет создан «Plan 2».  
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Сумма всех медиапланов (Total)  
В колонке Total рассчитываются показатели суммарного плана. Добавить Total можно на панели 

инструментов или через меню Tools => Options=>Documents=>Planner, поставив галку 

Show Total Plan 

 
 

 

Копирование медианосителей в отчет «План» из других отчетов  
 

В Galileo предусмотрена возможность копировать медианосители/медиапланы из одного отчета в 

другой. Например, можно скопировать издания, отобранные в отчете «Ranker», и добавить их в 

«Planner». Для этого сделайте следующее:  

 выделите медианосители в отчете «Ranker» и скопируйте с помощью кнопки 

(«Copy»),  

 откройте «Planner», вставьте медианосители из буфера обмена с помощью кнопки 

(«Paste»).  

 

Для того чтобы автоматически скопировалась целевая группа, для которой медианосители были 

отобраны, должна быть нажата кнопка («Include Target Audience») на панели 

инструментов. 

 
 

 

Добавление статистик в отчет  
Если нужно добавить дополнительные статистики, воспользуйтесь окном «Statistics» (левый 

нижний угол экрана). 
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Закладки «Plan 1», «Plan 2», «Plan N»  
В окнах «Plan 1», «Plan 2», «Plan N» можно анализировать вклад отдельных 

медианосителей в план.  

 
 

 

 

Окно «Plan 1» разделено на 2 части:  

 слева — атрибуты медианосителей (количество размещений, формат, цена, скидка и 

т.п.),  

 справа — статистики, рассчитанные для каждого издания в соответствии с количеством 

размещений.  

 

Внимание! Изменения в атрибутах, внесенные в окне «Plan 1», действительны только для 

данного плана и не распространяются на другие планы (например, «Plan 2»). Если вы изменили 

какой-то из атрибутов (например, цену или скидку) и хотите, чтобы это стало действительным 

для всех планов — выделите издания, в которые внесены изменения, и примените новый формат 

ко всем планам через меню Edit => Apply to all plans.  

 

В окне «Plan 1» можно анализировать эксклюзивный вклад каждого медианосителя в план с 

помощью статистик Exclusive Cover (Exclusive Cover %).  
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Exclusive Cover (Exclusive Cover %) — это эксклюзивный охват издания, т.е. охват, 

приносимый этим и только этим изданием или: какую часть охвата можно потерять, если не 

размещать рекламу в этом издании. Например, эксклюзивная аудитория издания «Караван» при 

4 размещениях рекламы = 48 тыс. человек (3.0% в целевой группе). Это значит, что 48 тыс. 

человек (3.0% в целевой группе) увидят рекламу только в издании «Караван» и не увидят ни в 

одном другом издании из «Plan 1». 

 
 
Пример интерпретации показателей медиаплана  
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 Total — в рамках первого плана планируется 17 размещений рекламы.  

 Cost — бюджет рекламной кампании равен 6 619 000 тенге.  

 Cover (Cover %) — охват рекламной кампании равен 70.57 тыс. человек (4.82% в 

целевой группе). Эти люди увидят рекламу хотя бы 1 раз.  

 Cover 3+ (Cover % 3+) — эффективный охват рекламной кампании равен 26.0 тыс. 

человек (2.0% в целевой группе). Эти люди увидят рекламу 3 раза и более.  

 

Примечание: уровни N+ можно задать через меню Tools => Options => Statistics. В 

поле «Cover N+» нажмите кнопку «Setting» и задайте значения N.  

 

 Frequency — средняя частота контакта с рекламой равна 2.22 (частота рассчитывается 

среди охваченных медиапланом).  

 OTS - количество контактов 156.79 тыс. с медианосителем/рекламой в целевой группе 

 CPT Cover — достижение каждой тысячи человек в целевой группе при такой схеме 

размещения будет стоить рекламодателю 93 799,26 тенге.  

 TGI — индекс соответствия целевой группе. Значение индекса 105 означает то, что 

данный медиаплан таргетирован на целевую группу: доля целевой группы среди тех, кто 

охвачен медиапланом, превышает долю целевой группы во всем населении в 1.05 раза. 

Чем больше индекс отклоняется от 100 в большую сторону, тем более ярко выражена 

направленность медиаплана на целевую группу.  

 Exclusive Cover (Exclusive Cover %) — эксклюзивный вклад данного плана в общий 

план. Если бы не существовало первого плана, то общий охват кампании Cover (Cover %) 

составил бы не 77.84 тыс., а 77.84 – 55.0 = 22.84 тыс. человек (в процентах: 5.32% – 

4.0% = 1.32%).  
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Оптимизатор (Optimiser) 
 

Функция  
Оптимизация медиаплана.  

 

Построение  

Нажмите кнопку  («New»).  

 
 

 

 В левой части окна выберите «Оптимизатор».  

 Нажмите «ОК».  
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Шаг 1: Задайте целевую группу в окне «Target Group». Нажмите «Далее».  

 
 

Шаг 2: Выделите медианосители в дереве слева и перенесите в правую часть окна с помощью 

кнопки . Нажмите «Далее». 
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Шаг 3: Задайте атрибуты медианосителей. Нажмите «Готово».  

 
 

В открывшемся окне «Confirm operation target» выберите один из предложенных вариантов. 

 

 
 

 

 

Копирование медианосителей в «Optimiser» из других отчетов  
В Galileo предусмотрена возможность копировать медианосители из одного отчета в другой. 

Например, можно скопировать издания, отобранные в инструменте «Planner», и добавить их в 

«Optimiser». Сделайте следующее:  
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 выделите медианосители в отчете «Planner» и скопируйте их с помощью кнопки  

(«Copy»),  

 откройте «Optimiser» и вставьте медианосители из буфера обмена с помощью кнопки 

 («Paste»).  

 

Для того чтобы автоматически скопировалась целевая группа, для которой медианосители были 

отобраны, должна быть нажата кнопка  («Include Target Audience») на панели 

инструментов.  

 
 

 

Задание условий рекламной кампании  

 
 
 

Прежде чем запускать алгоритм оптимизации, нужно задать условия рекламной кампании.  
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Условия рекламной кампании  

 

В верхней части окна отредактируйте атрибуты медианосителей:  

 

 

 Unit price — стоимость 1 размещения рекламного сообщения. При формате «user defined» 

цена доступна для редактирования.  

 Discount — скидка в %. Если нужно задать несколько последовательных скидок, 

используйте знак «+» между скидками.  

 Total price — суммарная стоимость размещения с учетом количества выходов и скидок.  

 Date — дата последнего обновления цены (в нашем случае не влияет на результат, так 

стоимость вносим вручную).  

 Media weight — коэффициент, который применяется к охвату медиа (т.е. к параметру 

Cover). Используется в случае, когда предполагаемая аудитория рекламного сообщения 

меньше аудитории медианосителя. Диапазон коэффициента: от 0 до 1.  

 Minimum — минимальное количество размещений в каждом издании.  

 Maximum — максимальное количество размещений в каждом издании. Для каждого 

издания задайте максимально возможное количество размещений. Например, если 

продолжительность кампании 2 месяца, для ежемесячного издания максимальное 

количество размещений должно быть равным 2.  

 Necessity — поставьте галку напротив тех изданий, которые обязательно должны 

присутствовать в плане.  

 

 
 

Алгоритм оптимизации  

 

В «Optimiser» доступны 3 математических алгоритма: «Coordinate-wise descent» (Метод 

координатного спуска), «Feasible directions» (Метод возможных направлений) и «Gradient 

descent» (Метод градиентного спуска). В большинстве случаев наилучший результат 

оптимизации дает «Feasible directions». Рекомендуется использовать именно этот алгоритм. 
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Criterion (критерии оптимизации)  

В поле «Criterion» выберите тот показатель, максимизация/минимизация которого является 

приоритетной задачей.  

 

 
 

 

Limit 

В колонке «Limit» задайте параметры, которые известны до начала планирования и являются 

«ограничителями» плана: например, «Budget», Frequency и т.п.  
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Пример задания условий рекламной кампании: 

 
 

 

Оптимизация медиаплана  

Для того чтобы выполнить оптимизацию, нажмите кнопку («Continue») на панели 

инструментов или воспользуйтесь меню Optimiser => Continue.  

 
 

 

 

Когда оптимальное решение найдено, в колонке «Quantity» будет проставлено рекомендуемое 

количество размещений для каждого издания, а в колонке «Value» будут рассчитаны 

показатели оптимального медиаплана. Если программа не может оптимизировать медиаплан при 

заданных условиях, появится сообщение:  
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В этой ситуации необходимо скорректировать изначальные условия (например, увеличить 

бюджет и/или откорректировать заданный уровень Frequency) и запустить «Optimiser» 

повторно. Сделайте следующее:  

 нажмите кнопку («Restart») (или через меню Optimiser => Restart),  

 скорректируйте изначальные условия в колонке «Limit»,  

 нажмите кнопку  («Continue»).  

 

Добавление статистик в отчет  
Если нужно добавить дополнительные статистики, воспользуйтесь окном «Statistics». 
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Пример интерпретации показателей медиаплана  

 
 
 

 

 Quantity — при заданных условиях ПО рекомендует 16 выходов рекламных публикаций.  

 Budet — бюджет рекламной кампании = 5 890 000 тенге.  

 Cover (Cover %) — охват рекламной кампании равен 74.16 тыс. человек (5.07% в 

целевой группе). Эти люди увидят рекламу хотя бы 1 раз.  

 Cover 3+ (Cover % 3+) — эффективный охват рекламной кампании при заданных 

условиях (заданном бюджете) не достижим.  

 Frequency — средняя частота контакта с рекламой равна 2.26 (частота рассчитывается 

среди охваченных медиапланом).  

 OTS – общее количество контактов составит 167,68 тыс.  

 CPT Cover — достижение каждой тысячи человек в целевой группе при такой схеме 

размещения будет стоить рекламодателю 79 421.97 тенге.  

 Composition — если за 100% принять всех кто увидит рекламу, то среди них доля 

целевой группы составит 24.2%.  

 TGI — индекс соответствия целевой группе. Значение индекса 109 означает то, что 

данный медиаплан таргетирован на целевую группу: доля целевой группы среди тех, кто 

охвачен медиапланом, превышает долю целевой группы во всем населении в 1.09 раза. 

Чем больше индекс отклоняется от 100 в большую сторону, тем более ярко выражена 

направленность медиаплана на целевую группу.  
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Пересечение медиа (Duplication Table) 
 

Функция  
Анализ пересечения аудитории медианосителей.  

 

Построение  
 

 Нажмите кнопку  («New»).  

 
 

 В левой части окна выберите отчет «Duplication table».  

 Нажмите «ОК».  
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Откроется отчет «Duplication table».  

 
 

 

Отчет «Duplication table» строится аналогично отчету «Cover table». Основное различие 

состоит в том, что в «Cover table» носители добавляются только на одну ось («Media»), а в 

отчете «Duplication table» — на две оси («Media» и «Media2»). 

 

Добавьте медианосители в таблицу одним из двух способов:  

 выделите переменные в окне «Media» и перенесите их с помощью мышки внутрь таблицы 

на оси Media и Media 2  

 нажмите кнопку («Add») на верхней панели инструментов и выберите нужные 

переменные. При этом медианосители будут добавлены одновременно и в столбцы, и в 

строки таблицы.  
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Таблица приобретет следующий вид: 

 
 

 

Добавление статистик в отчет  
Если нужно добавить дополнительные статистики, воспользуйтесь окном «Statistics». 

 
 

 

Пример интерпретации статистик  
Описание статистик для «Издания1» (в строках таблицы), «Издания2» (в столбцах таблицы):  

 Cover (Cover %) — суммарная аудитория двух изданий в тыс. человек (% в целевой 

группе),  
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 Intersection (Intersection %) — количество человек в тыс. (% в целевой группе), 

читавших оба издания,  

 Intersection % (1) — доля читателей «Издания2» в аудитории «Издания1»,  

 Intersection % (2) — доля читателей «Издания1» в аудитории «Издания2»,  

 Exclusive Cover (1) (Exclusive Cover % (1)) — количество человек в тыс. (% в целевой 

группе), читавших «Издание1» и не читавших издание «Издание2»,  

 Exclusive Cover (2) (Exclusive Cover % (2)) — количество человек в тыс. (% в целевой 

группе), читавших «Издание2» и не читавших издание «Издание1»,  

 Exclusive % of Cover (1) — доля читателей «Издания1», не читавших «Издание2»,  

 Exclusive % of Cover (2) — доля читателей «Издания2», не читавших «Издание1».  

 

Пример пересечения изданий «Аргументы и Факты» и «Караван:  

 

 
 

 

 

 Cover (Cover %) — 256.41 тыс. человек (3.9% от ген. совокупности) читают хотя бы 

одно из изданий: либо «Аргументы и Факты», либо «Караван».  

 Intersection (Intersection %) — 21.32 тыс. чел. (0.32% от ген. совокупности) читают 

оба издания: и «Аргументы и Факты», и «Караван».  

 Intersection % (1) — 14.33% аудитории «Аргументы и Факты» читают также «Караван».  

 Intersection % (2) — 16.54% аудитории «Караван» читают также «Аргументы и Факты».  

 Excl. Cvr (1) / Excl. Cvr % (1) — 127.48 тыс. человек (1.94% от ген. совокупности) 

читают «Аргументы и Факты» и не читают «Караван».  

 Exclusive Cover (2) / Exclusive Cover % (2) — 107.6 тыс. человек (1.64% от ген. 

совокупности) читают «Караван» и не читают «Аргументы и Факты».  

 Excl. % Cvr (1) — 85.67% аудитории «Аргументы и Факты» не читают «Караван».  

 Excl. % Cvr (2) — 83.46% аудитории «Караван» не читают «Аргументы и Факты».  

 

На пересечении издания с самим собой рассчитываются показатели двух средних номеров 

данного издания.  

 

Например, Intersection % (1) на пересечении «Аргументы и Факты» с «Аргументы и Факты» = 

62.08. Это значит, что 62.08% читателей одного среднего номера издания «Аргументы и Факты» 

прочитают также и второй средний номер этого издания. 
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Анализ охвата N+ (OTS Table) 
 

Функция  
Анализ распределения охвата на разных уровнях час тоты контакта.  

 

Построение  

 Нажмите кнопку  («Новый документ»).  

 

 
 

 В левой части окна выберите отчет «OTS table».  

 Нажмите «ОК».  
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Откроется отчет «OTS table».  

 
 

 

Для того чтобы добавить в таблицу издания, нажмите кнопку  («Add»).  

 

 
 

 

Шаг 1: Выберите издания, в которых планируется сделать размещение рекламы. Нажмите 

«Далее».  

 
 

 

 

Шаг 2: В поле «Quantity» укажите количество размещений рекламы в каждом издании. 

Нажмите «Готово».  
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Редактирование оси OTS (Контакты)  

Для того чтобы отредактировать ось OTS (Контакты), дважды кликните по прямоугольнику  

 
 

  
 

 

 

Здесь задается количество контактов с рекламным сообщением.  
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Пример интерпретации статистик  

Описание статистик:  

 Cover — охват аудитории в тыс. человек (количество людей, которые видели рекламу 

определенное число раз),  

 Cover % — процент охвата в целевой группе (доля людей в целевой группе, которые 

видели рекламу определенное число раз),  

 Cover/Cover1+% — доля людей, видевших рекламу определенное число раз, среди 

людей, видевших рекламу хотя бы 1 раз. Рассчитывается как отношение показателя 

«Сover N+» к показателю «Сover 1+».  

 

Пример:  

 
 

 

 Cover — 297.685 тыс. человек в возрасте 15 лет и старше, проживающие в городах 

100 000+, увидят рекламу 1 раз и более в издании «Аргументы и Факты», 289.967 тыс. 

человек увидят рекламу 2 раза и более, 276.531 тыс. человек увидят рекламу 3 раза и 

более.  

 Cover % — 4.53% населения увидят рекламу 1 раз и более, 4.41% - увидят рекламу 2 

раза и более, 4.21% - увидят рекламу 3 раза и более.  

 Cover/Cover1+% — среди всех людей, видевших рекламу в издании «Аргументы и 

Факты» хотя бы 1 раз, 97.41% увидят ее 2 раза и более, 92.89% — 3 раза и более.  
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Накопление охвата (Cover Build Up Table) 

 
Функция  

Анализ накопления аудитории медианосителей.  

 

Построение  

 Нажмите кнопку  («New»).  

 
 

 

 В левой части окна выберите отчет «Cover Build Up Table».  

 Нажмите «ОК».  
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Откроется отчет «Cover Build Up Table».  

 
 

 

Отчет «Cover Build Up Table» строится аналогично отчету «Cover table». Для того чтобы 

добавить медианосители в таблицу, перенесите нужные переменные с помощью мышки из окна 

«Media» (слева) на белое поле таблицы (направо).  

 

Редактирование оси CBU (Выходы)  
Для того чтобы отредактировать ось CBU (Выходы), дважды кликните по прямоугольнику .  

 

 
 

 

Здесь задается количество вышедших номеров издания.  
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Аудитория (Cover) в колонке «∞» для изданий соответствует аудитории за полгода. 

Пример интерпретации статистик  

 

Описание статистик:  

 Cover — охват аудитории в населении (в тыс. человек), т.е. количество людей, которые 

увидят рекламу при размещении рекламы в N номерах издания,  

 Cover % — охват аудитории в населении (в %), т.е. доля людей в населении, которые 

увидят рекламу при размещении рекламы в N номерах издания,  

 Frequency — средняя частота контакта с рекламным сообщением.  

 

Пример:  

 
 

 

 Cover — если реклама размещена в 3-х номерах «Аргументы и факты», ее увидят 234,92 

тыс. человек.  

 Cvr % — если реклама размещена в 3-х номерах «Аргументы и факты», ее увидят 3.58% 

населения.  

 Frequen. — средняя частота контакта с рекламой при 3-х размещениях в издании 

«Аргументы и факты» = 1.9 раз.  
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Сохранение отобранных атрибутов, 
переменных (Basket) 

 
Функция  
Basket позволяет сохранить набор отобранных атрибутов, переменных для использования в 

других инструментах (Ranker, Planner, Optimiser). Этот инструмент полезен для обеспечения 

того, чтобы анализ данных в разных инструментах проводился с использованием одного и 

того же набора ограничений. Вы добавляете, редактируете и удаляете ограничения из 

корзины точно так же, как и в других инструментах. Создав таким образом корзину, вы 

можете сохранить ее для будущего использования. 

Построение  

 Нажмите кнопку  («New»).  

 
 

 

 В левой части окна выберите отчет «Basket».  

 Нажмите «ОК».  

 
 

 

Шаг 1: Выделите медианосители в дереве слева и перенесите в правую часть окна с помощью 

кнопки . Нажмите «Далее». 
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Шаг 2: Задайте условия (количество, стоимость, скидки). Нажмите «Готово».  

 
 

 

Для каждой вставки отображаются атрибуты, выбранные в диалоговом окне Create insertions 

and variables вместе со всеми выбранными носителями. 
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Для изменения ширины колонки необходимо сделать двойное нажатие на границу колонки. 

 

Созданный набор носителей и атрибутов можно использовать в отчетах Planner, Optimiser 
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Часть III. 
Статистические методы 

анализа данных  



Galileo 6.28 

91 
K Research Central Asia 2025 

Статистические методы 
анализа данных 

 
Кластерный анализ (Cluster Analysis) 

 
Функция  

 

«Кластерный анализ» позволяет разделить множество людей на однородные подмножества 

(т.е. кластеры). Предполагается, что все люди — это совокупность точек, расположенных в 

многомерном пространстве. Задача кластерного анализа — выделить однородные и относительно 

устойчивые группы людей по определенному набору характеристик. Исходными данными 

являются данные опроса. Можно выбрать целевую группу и набор переменных для анализа. 

Анализу могут подвергаться только количественные переменные или переменные, которые могут 

быть преобразованы в количественное представление (логические, например). В частности, для 

анализа можно использовать только те категориальные переменные, для которых можно 

определенным образом организовать категории и измерить расстояние между ними.  Например, 

можно анализировать социальный статус, но нельзя анализировать род занятий.    

Для измерения расстояния между кластерами используется Метрика Евклида. Пользователь 

может определить количество кластеров и в результате анализируемые данные будут разделены 

на кластеры. 

Описание метода. 

В качестве исходных данных для кластерного анализа необходима следующая информация:  

 набор характеристик, по схожести которых люди будут объединяться в группы,  

 количество групп («кластеров»), на которые требуется разбить исходную совокупность. 

Кластерный анализ в Galileo основан на статистическом методе k-средних. 

Суть метода: переместить произвольно выбранные центры кластеров в центры наибольших 

скоплений людей, ориентируясь на расстояния между людьми.  

1 шаг. В зависимости от числа заданных кластеров программа берет такое же количество 

наиболее удаленных друг от друга исходных точек (т.е. людей, между которыми наибольшее 

расстояние). Эти точки определяются как первичные центры кластеров. Далее, каждый 

человек относится к ближайшему центру. Таким образом, все люди распределяются по 

заданному числу кластеров. 

2 шаг. Происходит смещение первичных центров кластеров в центры тяжести (математическое 

ожидание кластера). Образуются вторичные центры кластеров. Далее, повторяется 

процедура, описанная в шаге 1 – люди перераспределяются между центрами кластеров 

(приписываются к ближайшим центрам). 

Шаг 2 будет повторяться до тех пор, пока расстояние, на которое смещаются центры 

кластеров, не станет ничтожно маленьким. В этом случае процесс кластеризации 

останавливается. Определяются окончательные центры и границы кластеров.  

 

 

  

Построение  

 Нажмите кнопку  («New»).  
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 В левой части окна выберите «Cluster Analysis».  

 Нажмите «ОК».  

 
 

1 шаг: Задайте целевую группу. Затем нажмите «Далее».  
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2 шаг: Выберите переменные, на основании которых будут вычисляться расстояния между 

людьми  («Add variable»).  

 

 
 

Кластерный анализ работает с категориальными переменными (Single Categorical) с 

единственным выбором или числовыми переменными. 

В том случае, если среди выбранных переменных есть категориальные переменные, их нужно 

оцифровать, т.е. каждой категории поставить в соответствие определенное число. В процессе 

кластеризации на основе этих значений будут вычисляться расстояния между людьми. Также эти 

значения потребуются для интерпретации получившихся кластеров.  

 

 

В рассматриваемом примере категориям переменной «Экономическое положение» присвоены 

значения 1, 2, 3, 4, 5 по мере увеличения уровня благосостояния.  

 

Экономическое 
положение 

Имеем возможность покупать все, что 
хотим (включая квартиру/дом) 

6 

Имеем возможность покупать дорогие 
вещи и автомобиль, но не сможем 
купить квартиру/дом 

5 

Имеем возможность купить основную 
бытовую технику, но не автомобиль 

4 

Достаточно денег на еду и одежду, но 
купить телевизор, холодильник или 
стиральную машину сложно 

3 

Достаточно денег на еду, но купить 
одежду сложно 

2 

Не достаточно денег даже на еду 1 

Не знаю/Затрудняюсь ответить 7 
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Переменную «Частота потребления сигарет» оцифровали, присвоив каждой категории 

среднее количество выкуриваемых сигарет 

Частота потребления 

сигарет 

До 5 сигарет в день 3 

6 - 10 сигарет в день 8 

11 - 15 сигарет в день 13 

16 - 20 сигарет в день 18 

Более 20 сигарет в день 30 

 

Обработка пропущенных и неопределённых значений. 

Нижняя часть окна разделена на две части: Missing answer (пропущенные значения) и Invalid  

answer (неопределенные значения) 

 

 
 

Missing answers (пропущенные значения) — это категория «нет ответа» / «затрудняюсь 

ответить». Респондент, который не дал ответа, может быть:  

 исключен из анализа («Exclude»),  

 включен в анализ с заданным значением («Include»), например, категория «Не знаю / 

Затрудняюсь ответить» в вопросе Экономическое положение может быть включена в 

анализ со значением категории «хватает на еду, но купить одежду сложно.  

 включен в анализ со случайным значением данной переменной («Random»).  

 

В том случае, если в категориальной переменной отсутствует категория «нет ответа», нужно 

выбрать вариант «No missing».  

 

Invalid  answer (неопределенные значения). Значения переменной для некоторых людей 

могут быть не определены (например, вопрос мог задаваться только мужчинам, для женщин 

значения данной переменной будут неопределенны). Возможны следующие варианты 

обработки неопределенных значений: человек исключается из анализа (exclude), человеку 

присваивается значение, заданное пользователем (replace wit h value), человеку присваивается 

случайное значение (random). 

 

 

Выбрав переменные и установив параметры для каждой переменной, нажмите «ОК».  

 

3 шаг: Задайте количество кластеров  
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Для того чтобы запустить алгоритм кластеризации, нажмите на кнопку ‘Готово’. Будет 

осуществлен поиск оптимальных центров кластеров по методу k-средних. 

Если это необходимо, можно самостоятельно задать значения центров кластеров. Для этого 

нужно пометить галкой опцию ‘Set cluster centers’ и в колонках ‘Cluster 1’, ‘Cluster 2’, … ‘Cluster 

n’ задать координаты центров кластеров. 

Анализ результата  
 

Окно «Statistics»  

 

В поле Initial показаны параметры целевой группы до разбиения на кластеры.  

Далее представлены кластеры.  

 
 

По каждому кластеру приведена следующая информация:  
 wTotal % — количество человек в кластере в % от целевой группы,  
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 wTotal — размер кластера в тыс. человек,  

 Sample  — количество человек в выборке, формирующее кластер,  

 Variance (Дисперсия) — дисперсия внутри кластера, т.е. разброс объектов, входящих в 

кластер относительно центра кластера. Дисперсия – это мера разброса значений 

случайной величины относительно её математического ожидания (условно среднего 

значения). Дисперсия целевой группы (строка Initial) равна 1 из-за нормализации данных. 

Чем больше количество кластеров, тем меньше дисперсия (т.е. тем меньше разброс 

объектов внутри кластера). Если кластер содержит идентичные объекты или только один 

объект, то внутри кластерная дисперсия равна 0.  

 Deviation  - внутри кластерное стандартное отклонение рассчитывается как квадратный 

корень из внутрикластерной дисперсии (Deviation = √Variance). 

Variance и Deviation – это характеристики разброса объектов (людей), принадлежащих 

данному кластеру, относительно его центра 

 Distance (Расстояние) — расстояние от центра кластера до центра ближайшего кластера. 

В строке Mean указано среднее расстояние между ближайшими соседями. Показатель 

Distance уменьшается с увеличением количества кластеров, но значительно медленнее, 
чем Variance (Дисперсия).  

Если соотношение между показателями Distance кластера и показателем Distance в 
строке Mean не превышает 2-3, то вероятно четких границ между кластерами нет. 

 Disp. index (Индекс)— отношение дисперсии кластера к средневзвешенной дисперсии.  

Индекс показывает, насколько разброс людей данного кластера отличается от среднего  

разброса. Чем больше значение Disp. Index, тем больше разброс внутри кластера в 

сравнении со средним по всем кластерам. 

 Mean – усредненные показатели кластеризации 

 Quality (Индекс качества разбиения) – показывает насколько распределение людей по 

кластерам отличается от нормального распределения (например, максимальное значение 

индекса (100%) означает, что разбиение идеально, т.е. объекты каждого кластера 

идентичны; минимальное значение индекса (0%) говорит о том, что распределение людей 

равномерно и кластеры не являются областями сгущения). Если параметр Индекс качества 

разбиения составляет 20% и более, можно сделать вывод о том, что кластеризация является 

явно выраженной, в противном случае распределение людей по кластерам считается 

неустойчивым. 

 Number of invalid cases (невалидные значения)– это число респондентов, исключенных 

из анализа вследствие пропущенных или неопределенных значений.  

 

При оценке качества разбиения следует исходить из того, что хорошее разбиение должно 

отражать реальную структуру целевой группы, а полученные кластеры должны 

представлять собой области с высокой плотностью объектов (людей), разделенные 

относительно пустыми пространствами. 

Во-первых, для оценки качества кластеризации используется показатель Quality (Индекс  

качества разбиения). Значения этого показателя равное 20% и менее указывает на то, 

что количество кластеров слишком мало для выявления областей с ярко выраженными 

отличиями. Если нельзя повысить Quality (Индекс качества разбиения) увеличивая 

количество кластеров, то следует сделать вывод, что распределение объектов (людей) 

аналогично равномерному. В этом случае следует обратить внимание на  Variance 

(Дисперсия). Эта величина показывает насколько дисперсия (разброс) объектов (людей) 

меньше относительно центра кластера по сравнению со средним показателем разброса (в 

строке Mean). Желательное значение показателя Variance (Дисперсия) – 0.6-0.7 и менее. 

 

Если размер кластера достаточно велик, а его Disp. Index много больше 100%, то этот 

кластер, вероятно, следует, еще разделить. 

 

Отношение Distance (Расстояние) к Deviation  должно превышать 3. Значение менее 3 

показывает, что количество кластеров следует увеличить.  
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Пример интерпретации статистик: 
 

Initial 

wTotal (wTotal%) - в результате выполнения кластерного анализа было охвачено 1141 тыс. 

человек (38,4% от целевой группы «Мужчины»). 

!!! Важно. Прежде чем разделять целевую группу на кластеры, программа нормирует 

значения переменных, которые участвуют в кластерном анализе (т.е. математическое 

ожидание характеристик всех людей целевой группы сводится к «0», дисперсия сводится к 

«1»). 

 

Variance – дисперсия всех людей целевой группы до разбиения на кластеры приведена к 

значению 1,0 !!! 

Mean 

Variance – средневзвешенная дисперсия кластеров составляет 0,344.  

Deviation – среднее среднеквадратичное отклонение кластеров составляет 0,587.  

Distance – среднее расстояние между центрами кластеров составляет  1,273. 

 

Quality (Индекс качества разбиения) = 36,8% и превышает пороговое значение 20%. Можно 

сделать вывод о том, что кластеризация явялется явно выраженной. 

 

Number of invalid cases – из анализа исключены 851 респондент вследствие пропущенных 

или неопределенных значений. 

Кластер 1 

wTotal (wTotal%) – размер ‘кластера 1’ составляет 669 тыс. человек (22,5% от целевой группы),  

Sample – ‘кластер 1’ сформирован за счет 283-х человек из выборки. 

Variance – дисперсия первого кластера составляет 0,313. 

Deviation – среднеквадратическое отклонение от центра ‘кластера 1’ составляет 0,56. 

Distance – расстояние от центра первого кластера до центра ближайшего кластера составляет 

1,028. 

Disp. Index = Variance  / Variance (Mean) *100 = 0,313 / 0,340 *100 = 91. 

Значение Disp. Index для первого кластера < 100. Можно сделать вывод, что ‘кластер 1’ в 

среднем более однороден, чем все остальные. 

 

Окно «Центры»  

 

Таблица содержит координаты центров кластеров и исходной целевой группы (‘Total’). Центры 

кластеров – это средние значения переменных для каждого кластера. Для категориальных 

переменных нецелое среднее значение означает, что центр лежит между соответствующими  

категориями. 
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Интерпретация центров кластеров зависит от того, каким образом были оцифрованы 

категориальные переменные. В данном примере:  

 

 «Частота потребления сигарет»  

До 5 сигарет в день           3 

6 – 10 сигарет в день          8  

11 – 15 сигарет в день               13  

16 – 20 сигарет в день               18  

Более 20 сигарет в день             30  

 

 «Экономическое положение                        

Имеем возможность покупать все, что хотим (включая квартиру/дом)    6  

Имеем возможность покупать дорогие вещи и автомобиль, но не сможем купить 

квартиру/дом           5  

Имеем возможность купить основную бытовую технику, но не автомобиль          4  

Достаточно денег на еду и одежду, но купить телевизор, холодильник или 

стиральную машину сложно        3  

Достаточно денег на еду, но купить одежду сложно     2 

Не достаточно денег даже на еду        1 

Не знаю/Затрудняюсь ответить        7 

 

  «Образование»  

Начальное, неполное среднее  1 

Среднее общее, среднее специальное 2 

Незаконченное высшее, высшее  3 

 

 

Пример интерпретации статистик:  

 

Строка Total (11.79; 3.845; 2.281)  

Среднего человека из целевой группы можно охарактеризовать следующим образом:  
 Частота потребления сигарет в день ~ 12 сигарет в день,  

 Экономическое положение между «Достаточно денег на еду и одежду, но купить 

телевизор, холодильник или стиральную машину сложно» и «Имеем возможность купить 
основную бытовую технику, но не автомобиль» = 3.845,  

 Образование между «Среднее общее, среднее специальное» и «Незаконченное высшее, 

высшее» = 2.281.  

 

Кластер 1 (11.344; 3.307; 1.988)  

Среднего человека из первого кластера можно охарактеризовать следующим образом:  
 Частота потребления сигарет в день ~ 11 сигарет в день,  

 Экономическое положение между «Достаточно денег на еду и одежду, но купить 

телевизор, холодильник или стиральную машину сложно» и «Имеем возможность купить 
основную бытовую технику, но не автомобиль» = 3.307,  

 Образование между «Начальное, неполное среднее» и «Среднее общее, среднее 

специальное» = 1.988.  

 

Кластер 2 (10.645; 3.677; 3.0)  

Среднего человека из второго кластера можно охарактеризовать следующим образом:  
 Частота потребления сигарет в день ~ 11 сигарет в день,  

 Экономическое положение между «Достаточно денег на еду и одежду, но купить 

телевизор, холодильник или стиральную машину сложно» и «Имеем возможность купить 

основную бытовую технику, но не автомобиль» = 3.677,  

 Образование Незаконченное высшее, высшее = 3.0.  
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Окно «Centers normalised»  

 

Значения переменных нормируются в процессе кластерного анализа, т.е. математическое  

ожидание целевой группы приводится к нулю, а дисперсия приводится к единице.  

Centers Normalized – это центры кластеров, рассчитанные для нормированных значений целевой 

группы. 

C помощью таблицы ‘Centers Normalized’  можно сделать вывод о том, насколько среднее 

значение кластера отличается от среднего значения всей целевой группы 

 
 

Пример интерпретации статистик: 

Смещение центра первого кластера относительно среднего значения целевой группы («0») составляет  

(-0,069; -0,434; -0,508). 

Смещение центра второго кластера относительно среднего значения целевой группы («0») составляет 

(-0,176; -0,136; 1,245). 

 

Окно «Distance»  

Таблица содержит попарные расстояния между нормированными центрами кластеров  
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Пример интерпретации статистик: 
Расстояние между нормированными центрами ‘кластера 1’ и ‘кластера 2’ составляет 1,029.  
Расстояние между нормированными центрами ‘кластера 1’ и ‘кластера 5’ составляет 1,861.  
Расстояние между нормированными центрами ‘кластера 5’ и ‘кластера 2’ составляет 1,699. 
Расстояние между нормированными центрами ‘кластера 5’ и ‘кластера 3’ составляет 1,32.  
 

 

Управление кластерным анализом. 

В Galileo предусмотрена возможность уже после выполнения кластерного анализа менять 

изначальные условия: набор признаков, по которым люди объединяются в кластеры, 

количество кластеров. 

Для того, чтобы отредактировать переменные, в меню Edit выберите пункт Variables 

 

 

Изменить количество кластеров можно через меню Edit => Clusters. 
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Сохранение кластерной переменной  

 

Кластеры можно сохранить в виде пользовательской переменной через меню Tools => Cluster 

Variable. Укажите имя переменной и папку для ее размещения. 

 
 

 

Созданная переменная сохранится в дереве переменных. С ней можно работать в любых отчетах 

Galileo. 
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Сегментационный анализ  
(Segmentation Analysis) 

 
Функция  

«Сегментационный анализ» позволяет по определенному набору характеристик 

«предсказать» поведение группы людей. Под поведением группы может пониматься как 

потребительское поведение (например, потребление продукта), так и медиапредпочтения 

группы. 

 
Описание метода  

 

В качестве исходных данных для сегментационного анализа необходима следующая 

информация:  

 Целевая группа, поведение которой необходимо «предсказать» (например, потребители 

воды) 

 «предсказываемый» признак (например, частота потребления воды),  

 набор характеристик, с помощью которых требуется «предсказать» поведение группы 

(например: пол, возраст, социально-экономический класс).  

 

На первом этапе сегментационного анализа программа перебирает заданные характеристики и 

определяет ту, которая наибольшим образом влияет на поведение группы (например, что 

сильнее всего влияет на частоту потребления воды: пол, возраст или социально-экономический 

класс?). Затем на основании выбранной характеристики люди делятся на подгруппы так, чтобы в 

одной подгруппе оказались люди, обладающие сходным поведением, а в разных группах — 

люди, поведение которых принципиально отличается.  

На следующем этапе аналогично сегментируются образовавшиеся подгруппы: для каждой 

подгруппы программа ищет именно ту характеристику, которая сильнее всего влияет на 

поведение данной подгруппы и разделяет людей именно по этому признаку.  

Сегментация на подгруппы будет продолжаться до тех пор, пока размер конечных подгрупп не 

достигнет минимально допустимого значения (0,01% в целевой группе или 30 человек в 

выборке).  

 

В Galileo сегментационный анализ представлен двумя методами: CHAID и XAID. Выбор метода 

зависит от типа «предсказываемой» переменной: CHAID работает с категориальными 

переменными с единственным выбором, а XAID используется в том с лучае, если 

«предсказываемый» признак задан числовой переменной.  

В методе CHAID выбор переменной осуществляется с помощью chi-2 (критерий хи-квадрат). 

Программа проверяет гипотезу о независимости переменных и склеивает те градации, для 

которых значение критеря chi-2 не превышает критического значение и является наименьшим. 

Признаки, по которым разбивается совокупность, те для которых chi-2 превышает критическое 

значение и является наибольшим.  

В методе XAID выбирается такая переменная, по значениям которой в получившихся группах 

дисперсия (мера разброса относительно математического ожидания) меньше дисперсии в 

исходной совокупности и является наименьшей среди других вариантов.  

 

Построение  

 Нажмите кнопку  («New»).  
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 В левой части окна выберите «Segmentation Analysis».  

 Нажмите «ОК».  

 

 
 

 

1 шаг: На первом шаге Вы можете ограничить генеральную совокупность, задав целевую 

группу, внутри которой будет проводиться анализ. Задание целевой группы не является 

обязательным условием для проведения анализа. Вы можете пропустить этот шаг, нажав 

«Далее». 
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2 шаг: Определение «предсказываемого» признака и набора характеристик, с помощью 

которых требуется «предсказать» поведение группы. 

«Предсказываемый» признак называется зависимой переменной (Dependent Variable) . 

Переменные, с помощью которых «предсказывается» определенное поведение называются 

предикторами (Predictor Variables). 

 

 
 

В качестве зависимой переменной в анализе по методу CHAID должна быть определена 

категориальная переменная с единственным выбором, а в анализе по методу XAID — числовая 

переменная.  
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В верхней части окна можно для каждого предиктора выбрать тип (Type) группировки людей: 

‘Free’ – алгоритм может объединять в одну группы людей, принадлежащих любым категориям 

переменных-предикторов; ‘Monotonic’ - алгоритм может объединять в одну группы людей, 

принадлежащих только соседним категориям переменных-предикторов. 

 

 
Обработка пропущенных и неопределенных значений 

В нижней части окна для каждой переменной необходимо определить, каким образом будут 

учитывать в процессе анализа Missing answers (пропущенные значения) и Invalid answers 

(неопределенные значения). 

 

Missing answers (пропущенные значения). Любое значение переменной может быть 

объявлено «отсутствием ответа» (например, категория «затрудняюсь ответить»). Человек с 

пропущенным ответом может быть исключен из анализа (exclude), включен в анализ с 

имеющимся значением данной переменной (include), включен в анализ со случайным значением 

данной переменной (random).  

В том случае, если в категориальной переменной отсутствует категория «нет ответа», нужно 

выбрать вариант ‘No missing’. Если присутствует категория «нет ответа» - лучше исключить этих 

людей из анализа. 

 

Invalid answers (неопределенные значения). Значения переменной для некоторых людей 

могут быть не определены (например, вопрос мог задаваться только мужчинам, для женщин 

значения данной переменной будут неопределенны). Возможны следующие варианты 

обработки неопределенных значений: человек исключается из анализа (exclude), человеку 

присваивается значение, заданное пользователем (replace with value), человеку присваивается 

случайное значение (random). 

 

 

Определив Dependent и Predictor переменные, нажмите «Далее». 

 

3 шаг: Задайте алгоритм сегментации и параметры сегментов 
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Depth Limit  - максимальное количество уровней, на которые может ветвиться дерево.  

Minimal group size (as a proportion) - минимальный размер групп, полученных в результате 

сегментации (в процентах от целевой группы). 

Minimal group (as a sample) - минимальный размер групп, полученных в результате сегментации 

(по выборке). 

Maximal number of final group (segments) - максимальное количество групп, на которые может 

быть разделена целевая группа. 

 

  Нажмите «Готово». 

Анализ результата  
 

Окно «Diagram»  

Здесь представлено дерево сегментации. 
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Пример интерпретации статистик: 

Before chi-2 - значение, полученное после первоначального разбиения категорий по парам (до 

выполнения алгоритма CHAID). 

After chi-2 - значение, полученное в результате работы алгоритма CHAID.  

Значения Before chi-2 и After chi-2 являются критерием независимости между парой категорий 

и зависимой переменной и адекватности полученного разбиения ожидаемому.  

На первом шаге в качестве переменной, которая в наибольшей степени влияет на частоту 

потребления воды, была выбрана переменная «Возраст». По «Возрасту» группа потребителей 

воды была разделена на две группы. В группу 2 попали люди в возрасте 15-24 лет и 55+.  

Размер группы 2 составляет 1823 тыс. 559 человек (850 человек в выборке).  

На втором шаге в качестве разделяющей переменной было выбрано «Экономическое 

положение». 

И на третьем шаге в качестве разделяющей переменной был выбран Пол. 

 

Окно «Table»  

Здесь представлены параметры сегментов.  
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Например, рассмотрим группу «2-5»:  
 размер группы = 113.458 тыс. человек (48 человек в выборке),  

 в этой группе доля  активных потребителей воды составляет 38.2%, умеренных – 35.0%, 

пассивных = 13.1%  

 

Сегменты можно сортировать по одному из параметров. Для этого кликните мышкой по названию 

столбца. В этом примере сегменты отранжированы по убыванию активных потребителей.  

 
 

Уже после того как анализ выполнен, Вы можете поменять исходные условия и пересчитать 

результат. Например, можно добавить/удалить переменные, участвующие в сегментации через 

меню Edit => Variables. 

 
 

Изменить количество сегментов можно через меню Edit => Algorithm => кнопка «Stop 

Conditions».  
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Сохранение результата анализа в виде переменной  

 

Полученную сегментацию можно сохранить в виде переменной через меню Tools => 

Segmentation variables. 

 
 

Укажите название переменной в поле «Имя». 
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Можно автоматически задать названия сегментов. Для этого выделите все сегменты и нажмите 

кнопку («Make up»). 

 

 
 

Созданная переменная появится в дереве переменных. Ее можно добавить в «Кросс -таблицу» и 

рассчитать данные. 
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CORRESPONDENCE ANALYSIS 
 

Функция 

Анализ соответствия (Correspondence Analysis) – это графический инструмент анализа таблиц 

пересечений. Используется для визуализации таблиц пересечений, позиционирования 

торговых марок и медиа носителей. 

Метод выявляет взаимосвязи между признаками в строках и столбцах кросс -таблицы.  

 

Построение  

1. На первом этапе постройте Cross или Cover Table с двумя осями, на каждой из которых лежит 

не менее трех признаков1. Если это необходимо, задайте целевую группу. 

2. Перетащите мышкой серый прямоугольник             в левый верхний угол на поле Add Plane 

(новый слой) и выберите в окошке ниже статистику wTotal или Cover с помощью кнопки      

 
 

3. Затем выделите все клетки таблицы, кроме строки и столбца Total, и нажмите кнопку 

Correspondence Analysis  

 

 

 

 

                                                                 
1 Correspondence Analysis может быть использован для анализа любой таблицы размерности 
3 * 3 или больше 
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В результате выполнения Correspondence Analysis создается набор факторов. Число факторов 

на единицу меньше минимальной размерности исходной таблицы. Эти факторы используются 

для объяснения взаимосвязи между категориями таблицы. 

Каждый из построенных факторов объясняет определенную часть информации, содержащейся 

в исходной таблице. Доля информации, которую объясняет конкретный фактор, называется 

инерцией фактора (в нашем примере инерция первого фактора равна 85,2%, второго фактора 

– 9,5%). В сумме инерция всех факторов = 100%. 

Результаты анализа соответствия представлены в виде четырех отчетов (Graphic, Factors, Rows, 

Columns): 

 Графический отчет (закладка Graphic) – основной отчет анализа соответствия. Он 

используется для визуального анализа степени соответствия категорий между собой.  

 В качестве осей двумерного графика выбираются два фактора с наибольшей инерцией. 

Чем больше сумма инерций выбранных факторов, тем лучше график отражает исходную 

таблицу. 

 Категории исходной таблицы изображаются в виде точек на двумерном графике 

(координатами которых являются значения факторов).  

Точки на графике делятся на 2 вида: 

 (красный квадрат) – соответствует категориям, расположенным в столбцах 

исходной таблицы 

 (синий кружок) – соответствует категориям, расположенным в строках исходной 

таблицы 

Подписи точек на графике, шрифт можно редактировать через правую кнопку мыши: 
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Важно помнить, что анализ соответствия не позволяет получать количественных 

характеристик соответствия или близости категорий. Иными словами, он позволяет сделать 

вывод о том, что категория А ближе к категории С, чем категория В, но не позволяет 

определить, насколько. 

 Таблица факторов (закладка Factors) содержит детальную информацию по каждому 

фактору. Факторы расположены в порядке убывания их значимости.  

 

Для каждого фактора рассчитываются следующие показатели:  

 Собственное значение (Singular Value) – соответствует коэффициенту корреляции 

Пирсона между строками и столбцами для данного фактора.  

 Инерция (Inertia) – мера взаимосвязи между переменными в кросс -таблице. 

 Инерция % (Inertia%) – относительная значимость фактора. Фактор считается значимым, 

если его инерция% не менее чем частное 100% и числа факторов.  

 Кумулятивная инерция % (Cum.Inertia%) – равна сумме инерций всех факторов. 

 Отчеты по строкам и столбцам (закладки Rows и Columns) – содержат детальную 

информацию об отдельных категориях. Число факторов, которые отображаются в отчетах, 

можно задать с помощью диалогового окна Options => Correspondence. По умолчанию 

предложена информация по первым двум факторам. 

Для каждой категории отображаются следующие показатели: 

 Вес (Weight) – сумма всех значений категории, разделенная на сумму значений всех 

элементов таблицы, 

 Вклад (Contribution) показывает относительную значимость категории для данного 

фактора, 

 Полный вклад (Contribution Total) равен сумме вкладов всех активных категорий, 

 Квадрат коэффициента корреляции (Squared Correlation) показывает относительную 

значимость фактора для данной категории, 

 Качество представления (Representation Quality) показывает, насколько хорошо 

категория представлена данным набором факторов.  

 

Каждая категория может быть помечена как «пассивная» (Passive) и исключена из анализа.  

Каждая категория может быть помечена как «спрятанная» (Hide) и скрыта на графике, при 

этом она не будет исключена из анализа. 
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Анализ результатов 

Графический отчет  

 

В результате выполнения анализа соответствий были созданы 5 факторов. Количество 

факторов определяется по формуле: 

n = количество столбцов в исходной таблице – 1 

Для нашего примера: n = 6 - 1 = 5 

В качестве осей на графике выбраны два наиболее значимых фактора. 

Инерция 1 фактора (по горизонтали) = 85,2% 

Инерция 2 фактора (по вертикали) = 9,5% 

Для анализа взаимосвязи признаков большое значение имеет цвет точек. Различают 2 способа 

анализа: анализ точек одного цвета, анализ точек разных цветов.  

 

1)  Для точек одного цвета: чем ближе точки друг к другу, тем больше связаны между собой 

соответствующие категории по рассматриваемым характеристикам.  
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а) близость точек Фантастика и Триллеры означает то, что этим жанрам отдают предпочтение 

люди примерно одного пола/возраста. 

 

 

 
б) предпочтения по жанрам у групп Женщины 25-54 и Женщины 15-24 лет более схожи, чем 

предпочтения у группы Мужчины 15-24 лет 

 

 

Для точек разных цветов: чем острее угол между точками от начала координат, тем более 

связаны друг с другом признаки. 

 

 
 

Например, группа Женщины 25-54 лет в большей степени отдают предпочтение 

Комедии, Юмору и Музыкальному жанру. 



Galileo 6.28 

116 
K Research Central Asia 2025 

Таблица факторов: 

 

В таблице факторов приведена подробная информация по пяти факторам, которые были 

построены в результате анализа соответствий. 

Галочкой отмечены факторы, которые в данные момент отображены на графике. Для того чтобы 

вывести на график другие факторы, пометьте их галочкой. Одновременно на графике могут 

быть отображены только два фактора. 

Первые два фактора являются наиболее значимыми. 

Inertia % для фактора 1 = 85,2% 

Inertia % для фактора 2 = 9,5% 

Cum. Inertia % для фактора 1 и фактора 2 = 94.7%. 

Можно сделать вывод, что первые два фактора отображают ~ 95% информации, содержащейся 

в исходной таблице. 

 

Отчет по строкам: 
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В отчете по строкам представлена детальная информация по каждому жанру. 

По умолчанию выведены характеристики только по первым двум факторам. Изменить 

количество факторов можно с помощью диалога Tools =>Options => Correspondence. 

 

Sq. Correlation (1) – показатель того насколько сильно категория связана с фактором, т.е. 

полововозрастной состав жанра Боевики на 98,1% объясняется расположением точки Боевики 

относительно фактора 1. 

Sq. Correlation (2) – корреляция жанра Боевики с фактором 2 составляет 0,013. Т.е. 

полововозрастной состав жанра Боевики на 1.3% объясняется расположением точки Боевики 

относительно фактора 2. 

Repr. Quality = Sq. Correlation (1) + Sq. Correlation (2) 

Качество представления жанра Боевики с помощью фактора 1 и фактора 2 = 0,994. 

Т.е. с точки зрения фактора 1 и фактора 2 половозрастной состав жанра Боевики объясняется 

на 99,4%. 

Contribution (1) – вклад жанра Боевики в формирование фактора 1 = 0,319, т.е. Жанр Боевики 

на 31.9% определяет расположение фактора 1. 

Contribution (2) – вклад жанра Боевики в формирование фактора 2 = 0,038, т.е. Жанр Боевики 

на 3.8% определяет расположение фактора 2. 

Weight – вес категории Боевики составляет 0,096. Если принять за 100% сумму всех клеток 

исходной таблицы, то сумма клеток в строчке Боевики составит 9,6% исходной таблицы. 

 

Жанр Боевики можно исключить из анализа, поставив крестик в ячейку Passive.  

Жанр Боевики можно скрыть (не отображать на графике, не исключая из анализа), поставив 

крестик в ячейку ‘Hide’. 

 

Для того чтобы скрыть / отобразить  на графике все категории, выделите мышкой с толбец ‘Hide’, 

кликните по выделенному столбцу правой клавишей мыши и выберите:  

‘Hide’ – для того чтобы скрыть все выбранные категории, 

‘Show’ – для того чтобы отобразить все выбранные категории. 

 

Отчет по столбцам: 

 
 

В отчете по строкам представлена детальная информация для каждой половозрастной группы. 

По своей структуре отчет по столбцам аналогичен отчету по строкам.  

По умолчанию выведены характеристики только по первым двум факторам.  
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Sq. Correlation (1) – корреляция группы М 15-24 лет с фактором 1 составляет 0.805. Т.е. 

предпочтения группы М 15-24 по типам Фильмов и Сериалов на 80,5% объясняется 

расположением точки М 15-24 относительно фактора 1 

Sq. Correlation (2) – корреляция группы М 15-24 лет с фактором 2 составляет 0.144. Т.е. 

предпочтения группы М 15-24 по типам Фильмов и Сериалов на 14,4% объясняется 

расположением точки М 15-24 относительно фактора 2 

Repr. Quality = Sq. Correlation (1) + Sq. Correlation (2) 

Качество представления категории М 15-24 лет с помощью фактора 1 и фактора 2 = 0,949. 

Т.е. с точки зрения фактора 1 и фактора 2 категория М 15-24 лет объясняется на 94,9%. 

Contribution (1) – вклад категории М 15-24 лет в формирование фактора 1 = 0,097. Т.е. группа 

М 15-24 лет на 9.7% определяет расположение фактора 1. 

Contribution (2) - вклад категории М 15-24 лет в формирование фактора 2 = 0,156. Т.е. группа 

М 15-24 лет на 15.6% определяет расположение фактора 2. 

Weight – вес категории М 15-24 лет составляет 0,055. Если принять за 100% сумму всех клеток 

исходной таблицы, то сумма клеток в строчке М 15-24 составит 5.5% исходной таблицы. 

 

Каждую категорию можно исключить из анализа, поставив крестик в ячейку Passive.  

Каждую категорию можно скрыть (не отображать на графике, не исключая из анализа), 

поставив крестик в ячейку ‘Hide’. 

 

Оформление графика 

Результат анализа можно оформить в PowerPoint – подчеркнуть, что в каждом треугольнике – 

сегменте собраны жанры наиболее популярные в определенных половозрастных группах.  
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Контактная информация: 

В случае возникновения каких-либо вопросов, связанных с работой ПО Galileo, пожалуйста, 

свяжитесь со специалистами компании K Research Central Asia: 

Телефон +7 727 347 05 03    

 

 
 


